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Chapter 6
Communication Technologies
Projects require teamwork, and team members must communicate with each other
in a variety of ways. The documents they produce must be collected, distributed,
and stored in an appropriate manner to assure timely and accurate communication
between team members. This process is often assisted by a variety of technologies
and computer software products. Communication technology can facilitate faster
and better communication, or it can become a barrier if the technologies are not
well understood and applied appropriately.
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6.1 Types of Communication
LEARNING OBJECTIVES
1. Identify characteristics and examples of synchronous communication.
2. Identify characteristics and examples of asynchronous communication.
3. Identify questions to answer when considering new communications
technologies.

Completing a complex project successfully requires good communication among
team members. If those team members work in the same building, they can arrange
regular meetings, simply stop by each other’s office space to get a quick answer, or
even discuss a project informally at other office functions. Many projects are
performed by teams that interact primarily through electronic communication and
are, therefore, called virtual teams.Business Dictionary, s.v. “Virtual Team,”
http://www.businessdictionary.com/definition/virtual-team.html (accessed
January 27, 2010). To avoid miscommunication that can harm trust and to include
team members in a project culture, the project team needs a plan for
communicating reliably and in a timely manner. This planning begins with
understanding two major categories of communication.

Synchronous Communications
If all the parties to the communication are taking part in the exchange at the same
time, the communication is synchronous. A telephone conference call is an example
of synchronous communication. When the participants are not interacting at the
same time, the communication is not synchronous, or asynchronous.
The following are examples of synchronous communications:
• Live meeting. Gathering of team members at the same location.
• Audio conference. A telephone call between two individuals or a
conference call where several people participate.
• Computer-assisted conference. Audio conference with a connection
between computers that can display a document or spreadsheet that
can be edited by both parties.
• Video conference. Similar to an audio conference but with live images of
the participants. Some laptop computers have built-in cameras to
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facilitate video conferencing, as shown in Figure 6.1 "Video
Conferencing by Laptop".
Figure 6.1 Video Conferencing by Laptop

© 2010 Jupiterimages Corporation

• IM (instant messaging). Exchange of text or voice messages using pop-up
windows on the participants’ computer screens, as shown in Figure 6.2
"Instant Messaging Pop-Up Window".

6.1 Types of Communication
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Figure 6.2 Instant Messaging Pop-Up Window

• Texting. Exchange of text messages that are 160 characters or fewer
between mobile phones, pagers, or personal digital assistants
(PDAs)1—devices that hold a calendar, a contact list, a task list, and
other support programs. See Figure 6.3 "Texting via Cell Phone".

1. Device that holds a calendar, a
contact list, a task list, and
other support programs.

6.1 Types of Communication
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Figure 6.3 Texting via Cell Phone

© 2010 Jupiterimages Corporation

Time Zones
The worldwide communication network makes it possible to assemble project teams
from anywhere in the world. Most people work during daylight hours, which can
make synchronous meetings difficult if the participants are in different time zones,
where they start, end, and take meal breaks at different times. It can be an
advantage in some circumstances. For example, if something must be done by the
start of business tomorrow, team members in Asia can work on the problem during
their normal work hours while team members in North America get some sleep.

6.1 Types of Communication
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Figure 6.4 World Time Zones

© 2010 Jupiterimages Corporation

As the earth turns, the sun appears to move across the sky from east to west. Local
noon occurs when the sun is at its highest position in the sky. Cities and countries
to the north or south of each other all observe local noon at the same time. For
example, noon in New York occurs at the same time as it does in Bogotá, Colombia,
in South America. Be aware that many well-educated people in the United States
think of South America as directly south of North America. As you can see in Figure
6.4 "World Time Zones", most of South America is one or two time zones east of the
United States.
To prevent confusion between a.m. and p.m., times are given using a twenty-fourhour clock. Noon is 12:00 and 1 p.m. is 13:00, and parts of an hour are divided by
colons. For example, 13:25:21 is thirteen hours, twenty-five minutes, and twentyone seconds.

Local Time
Local time is compared to the time zone that is centered at the historically
significant naval observatory at Greenwich, England. The time at that location is

6.1 Types of Communication
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Greenwich Mean Time (GMT)2. More recent references use UT for Universal Time
(UT)3 instead of GMT.

Conference Call between New York and Paris
A project manager in New York is five time zones west of the reference zone, so
the time is given as UT –5 (or GMT –5). If it is noon in the reference zone, it is 7
a.m. (five hours earlier) in New York. The manager would like to contact a
project team member in Paris, France. Paris is one time zone west of the
reference zone (UT +1 or GMT +1). If it is noon (12:00) in the reference zone, it is
13:00 (1 p.m.) in Paris.
This means that there is a six-hour difference between New York and Paris. If
the project manager waits until after lunch to place the call (1 p.m. in New
York), it might be too late in the day in Paris (7 p.m.) to reach someone.

Asynchronous Communications
Getting a team together at the same time can be a challenge—especially if they are
spread out across time zones. Many types of communication do not require that the
parties are present at the same time. This type of communication is not
synchronous; it is asynchronous. There are several choices of asynchronous
communications.

Mail and Package Delivery
2. Time zone system historically
based on the naval observatory
at Greenwich, England.
3. Time zone system that is
compatible with GMT but
without the historical
reference.
4. Device that scans a document
and converts it to electronic
signals that can be transmitted
by telephone to another fax
machine, which can reproduce
the original document.
5. A duplicate (see telefacsimile).

6.1 Types of Communication

Many companies prefer that final contracts are personally signed by an authorized
representative of each party to the agreement. If several signatures are required,
this can take weeks to get all the signatures if the contracts are transferred by the
postal service. If this process is holding up the start of the project, you can use an
overnight delivery service to minimize the time spent transferring the documents.

Fax
A telefacsimile (fax) machine4 is a device that scans a document a narrow band at
a time converting it into tones that can be conveyed over traditional telephone
lines to a receiving device that reproduces a facsimile5—exact duplicate—of the
document. A fax machine typically has a paper feeder that can be used for feeding
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multiple-page documents, a telephone key pad and handset, and a status display, as
shown in Figure 6.5 "Fax Machine".
Figure 6.5 Fax Machine

© 2010 Jupiterimages Corporation

Transmission rates of fax machines are typically limited by the use of traditional
telephone lines. The data transmission uses the same method as a dial-up computer
modem. A Group 3 fax machine6 has a maximum data rate of 14.4 kilobits per
second (Kbps), but if the phone connection is poor, it will drop down to lower
speeds automatically until it can establish a reliable connection between machines.

6. Model of fax machine that uses
digital scanning and data
compression.
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The Group 3 fax machine digitizes data in a form that is compatible with computers
and the fax function is often integrated with other computer functions. A
multifunction device, such as the one shown in Figure 6.6 "Multifunction Printer,
Scanner, Fax, and Copier", can scan a document and save it as an image, send it as a
fax, or print multiple copies.
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Fax machines have been around a long time and enjoy a
high level of trust for transmitting documents
accurately. In many countries, a fax of a signed contract
is legal, but a computer-scanned image is not.

Figure 6.6 Multifunction
Printer, Scanner, Fax, and
Copier

Electronic Mail
Electronic mail (e-mail) is widely used to coordinate
projects and to communicate between team members. It
has several valuable characteristics for project
management:

© 2010 Jupiterimages
Corporation

• Copies can be sent to a list of team
members.
• A preconference-call e-mail can list the
agenda items of the conference call.
• A postconference e-mail can summarize the results of the discussion
on each topic.
• Messages can be saved to document the process in case of a
misunderstanding or miscommunication.
• Files can be attached and distributed.

Project Log and Web Log (Blog)
A Web log7 is typically called a blog. It is an online journal that can be private,
shared by invitation, or made available to the world. Some project managers keep a
journal in which they summarize the day’s challenges and triumphs and the
decisions they made. They return to this journal at a later date to review their
decision-making process after the results of those decisions are known to see if they
can learn from their mistakes. Many decisions in project management are made
with incomplete knowledge, and reflecting on previous decisions to develop this
decision-making skill is important to growth as a project manager.

Really Simple Syndication (RSS)

7. Online personal journal.
8. Communications technology
that allows news to be sent to a
computer screen.

6.1 Types of Communication

Some projects are directly affected by external factors such as political elections,
economic trends, corporate mergers, technological or scientific breakthroughs, or
weather. To keep informed about these factors, you can subscribe to online news
sources. A method that facilitates this process is Really Simple Syndication (RSS)8.
To use an RSS feed, team members download a free news reader on the Internet.
Web pages with RSS news feeds have labeled links, as shown in Figure 6.7 "Link to
RSS Feed on a Web Page".
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If the user clicks on the RSS feed, news from the Web
site is automatically sent to the user’s news reader. The
news reader can be set to filter the news for key words
to limit the stories to those that are relevant to the
project.

Figure 6.7 Link to RSS Feed
on a Web Page

The following are examples of asynchronous
communications:
• Mail and package delivery. Transfer of objects and contracts that need
signatures.
• Fax. Document transmittal over telephone. Facsimiles are accepted for
some documents.
• Electronic mail (e-mail). Text messages with attachments can be
distributed and managed by computer programs.
• Web log (blog). An online journal may be used to record events,
thoughts, and lessons learned.
• Really Simple Syndication (RSS). News feeds that push relevant content to
a reader to keep the manager informed of new events that could affect
the project.

Assessing New Communication Technologies
New technologies for communicating electronically appear with increasing
frequency. Using a new technology that is unfamiliar to the team increases the
technology complexity, which can cause delays and increase costs. To decide if a
new technology should be included in a communications plan, seek answers to the
following questions:
• Does the new communication technology provide a competitive
advantage for the project by reducing cost, saving time, or preventing
mistakes?
• Does the project team have the expertise to learn the new technology
quickly?
• Does the company offer support such as help desk and equipment
service for new communication technology?
• What is the cost of training and implementation in terms of time as
well as money?

6.1 Types of Communication
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KEY TAKEAWAYS
• Synchronous communications take place when all the parties are
present at the same time. Examples are telephone calls and video
conferencing.
• Asynchronous communications take place when the parties are not
present at the same time. Examples are e-mail, fax, package delivery,
blogs, and RSS feeds.
• Determine if a new technology can save time, reduce cost, or prevent
mistakes and if the increased complexity can be handled by the team
and support staff for an affordable cost in time and money.

EXERCISES
1. Communications methods that do not require both parties to participate
at the same time are called _______________.
2. A telephone call is an example of __________ communication.
3. An exchange of e-mail messages is an example of _______________
communication.
4. A __________ is an online journal used to share an individual’s thoughts
and experiences.
5. A video conference is an example of _____________ communications.
6. What are two examples of synchronous communications technologies
that you have used?
7. What are two examples of asynchronous communications technologies
that you have used?
8. What is a virtual team?
9. Where is the reference time zone and why is it sometimes referred to as
both GMT and UT?
10. Why are fax machines still used for legal documents?
Internalize your learning experience by preparing to discuss the following.
If you were managing a functional team that included people from three
other countries, which synchronous communications technologies would
you include in your communications plan and for what purposes? Which
asynchronous technologies would you use and for what purposes? What new
technologies would you consider?

6.1 Types of Communication
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6.2 Selecting Software
LEARNING OBJECTIVES
1. Identify the types of software that are appropriate for projects of low
complexity.
2. Identify the types of software that are appropriate for projects of
medium complexity.
3. Identify the types of software that are appropriate for projects of high
complexity.
4. Describe strategies for sharing documents that can be edited by a team.

Part of a communications plan is determining the type of computer software that
will be used to create documents, spreadsheets, diagrams, and reports. The choice
of software is related to the complexity of the project.

Simple Projects
Basic projects can be managed using some of the features available in generalpurpose software that is available in most offices.

Word Processing
Even the most basic project will generate numerous documents using word
processing software. A communications plan can specify standards for these
documents that makes it easier to create, edit, combine, store, and retrieve the
documents. Document standards include the following:
• Specifying the file format
• Using templates for commonly used forms

File Format
Word processing software programs display a document on a computer’s screen and
allow the user to enter and edit text. When the file is saved to a storage device, the
text and all the various formatting such as font and font size are converted to a
code for efficient storage. The code varies from one word processing program to
another and even between releases of the same program.
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The most common word processing program, by a wide margin, is Microsoft Word
(MS Word). Several releases of MS Word run on the Windows operating system and
on the Macintosh operating system. Versions of MS Word released prior to 2007
save files in a proprietary format. The format is indicated by a period and a threeletter extension—.doc—that is automatically attached to the file when it is saved.
Beginning with MS Word 2007 for Windows and MS Word 2008 for Macintosh, files
are saved using a different format that is indicated by a period and a four-letter
extension—.docx—that identify the newer format.
Almost all word processing programs have the ability to save files in the .doc file
format, and it is a common standard for word processing files. Newer versions of
word processing programs, including MS Word 2007 and MS Word for Mac 2008, can
save files in the older .doc format. There are new features in MS Word 2007—such as
the ability to format citations in a variety of styles, including APA, MLA, and
Chicago—that are lost when the file is saved in the .doc format. Older versions of MS
Word can be adapted to read the newer .docx file formats by downloading and
installing a compatibility program that is available at no cost from Microsoft’s Web
site. Display of document file extensions is hidden by default in the Windows
operating system. They can be displayed by turning off this feature. Instructions for
displaying the file extensions are available from the operating system’s help menu.
In the Windows Vista operating system, the option is found on the Control Panel, in
Appearance and Personalization, in Folder Options, on the View tab, under
Advanced Settings, as shown in Figure 6.8 "Displaying File Name Extensions".
Figure 6.8 Displaying File Name Extensions

6.2 Selecting Software
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When a list of files is displayed in a dialog box, choose the Details option. In
Windows Vista, the Details option is on the View button, as shown in Figure 6.9 "File
Extensions Displayed in Details View".
Figure 6.9 File Extensions Displayed in Details View

Styles
The combination of formatting, including font, font size, font color, shading, and
other attributes used to display a segment of text and to identify its level of
importance, is called a style9. A style can be given a name and applied repeatedly to
different portions of a document. Predefined styles are available in MS Word 2007
on the ribbon, on the Home tab, in the Styles group, as shown in Figure 6.10 "Style
Choices". Users can define their own styles and give them names. Some
organizations prefer that all of their documents have similar fonts and styles for
headings, body text, and figure captions.
Figure 6.10 Style Choices

Outlines

9. Combination of formatting,
including font, font size, font
color, shading, and other
attributes used to display a
segment of text and to identify
its level of importance.

6.2 Selecting Software

An outline of a document consists of topic headings and subheadings, and it is
useful when organizing or reorganizing a document. The Styles group in MS Word
2007 includes predefined styles for nine levels of headings. In addition to using
different fonts, each heading is assigned a level of importance. A document that
uses headings with assigned levels can be viewed in the Outline view, such as the
book outline shown in Figure 6.11 "Outline View in MS Word 2007". In this view, the
level of detail displayed in the outline is selected to display the first two levels of
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the outline. The headings and the hidden text associated with each heading can be
moved by selecting and dragging headings from one location in the outline to
another.
Figure 6.11 Outline View in MS Word 2007

Templates
If a particular type of document will be used repeatedly, it might be worth the time
to create an example document—a template10—that is formatted using the
appropriate styles with blanks or placeholder text where the user can insert the
information that describes a particular situation. A variety of templates are already
available for download at no additional cost. For example, when a new document is
created in Microsoft Word 2007, there is an option to choose a template such as the
invoice template shown in Figure 6.12 "Standardized Document Used as a
Template".

10. An example document that
uses standard design features
that can be completed to create
similar documents.

6.2 Selecting Software
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Figure 6.12 Standardized Document Used as a Template

The template may be customized and used repeatedly for all the documents of that
type, or the organization can design its own.

Diagrams
Reporting relationships and the flow of work are often described using diagrams
that consist of boxes connected by arrows. Recent releases of popular word
processing programs include drawing tools that can be used for basic diagrams. In
MS Word 2007, a variety of shapes and connectors are available on the Insert tab, in
the Illustrations group on the Shapes button, as shown in Figure 6.13 "Menu of
Diagramming Shapes and Connectors in Word 2007".

6.2 Selecting Software
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Figure 6.13 Menu of Diagramming Shapes and Connectors in Word 2007

Adaptable connecting lines and arrows can be used that redraw automatically when
the shapes are moved. This feature facilitates rapid revisions when the shapes must
be moved, because the connecting arrows do not need to be redrawn.
A feature named SmartArt was introduced in Microsoft Office 2007 that has a
variety of charts that can be used for displaying organization and relationships that
use more sophisticated and artistic graphics, as shown in Figure 6.14 "SmartArt
Feature in Microsoft Word".

6.2 Selecting Software
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Figure 6.14 SmartArt Feature in Microsoft Word

Spreadsheets
Another commonly available software creates a spreadsheet11—a display of data in
row and column format—in which financial or numerical data can be manipulated.
The intersection of the rows and columns are cells into which numbers, text, dates,
and formulas can be entered. The formulas can utilize values found in other cells
and display the results in the cell in place of the formula. If the value in a cell to
which the formula refers is changed, all the formulas that use that cell’s value are
immediately recalculated. This feature makes it convenient to examine several
options quickly. Spreadsheets are often used to manage data on simple projects
instead of a dedicated database or project management software.

Organizing Data in Rows and Columns

11. Display of data in row and
column format.
12. Group of data that is organized
in rows and columns, where
columns are types of data and
rows are individual instances.

6.2 Selecting Software

If a spreadsheet is used to store data, such as a list of project activities or a list of
expenses, it is prudent to arrange the data in some way that would be used by more
sophisticated data management software. Most data management programs
arrange data in such a way that each type of data is represented by a column with a
label at the top and each row contains the specific data for one type of item. A
collection of data arranged in rows and columns is a table12. For example, a list of
expenses would be arranged so that individual expenses are recorded on each row,
and each column would be a type of information related to the expenses, as shown
in Figure 6.15 "Expenses Arranged in a Table in a Spreadsheet".
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Figure 6.15 Expenses Arranged in a Table in a Spreadsheet

File Format
The most common spreadsheet program, by a wide margin, is Microsoft Excel (MS
Excel). There have been several releases of MS Excel that run on the Windows
operating system and on the Macintosh operating system. Versions of MS Excel
released prior to 2007 save files in a proprietary format. The format is indicated by
a period and a three-letter extension—.xls—that is automatically attached to the file
when it is saved. Beginning with MS Excel 2007 for Windows and MS Excel 2008 for
Macintosh, files are saved using a different format that is indicated by a period and
a four-letter extension—.xlsx—that identifies the newer format.
Almost all spreadsheet programs have the ability to save files in the .xls file format,
and it is a common standard for spreadsheet files. Newer versions of spreadsheet
programs, including MS Excel 2007 and MS Excel for Mac 2008 can save files in the
older .xls format. There are a few new basic features in MS Excel 2007 that would be
lost by saving files to the older file format.

Using a Spreadsheet to Manage Project Data
If the data in the spreadsheet is arranged in simple rows of the same type of data, it
can be manipulated to provide reports for basic projects.

13. Display is restricted to data
that meets criteria.

6.2 Selecting Software

If one or more of the columns in a table contain labels, identification numbers, or
other descriptions, those labels can be used to specify sorting and filtering options.
For example, if the spreadsheet has a list of expenses, the rows of data can be sorted
in decreasing or increasing value by one of the data types such as the due date or
the amount of the expense. The display can be restricted—filtered13—to display
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only those rows that meet criteria specified by the user. For example, the table
could be filtered to display the expenses for a particular department that were
incurred between two dates. This ability facilitates the preparation of monthly
progress reports and budgets.
In MS Excel 2007, the sorting and filtering options are on the Data tab, in the Sort
and Filter group under the Sort or Filter button. Once a filter is applied, option
buttons are placed at the top of each column to facilitate changes in the sorting or
filtering options. For example, the list of expenses shown in the previous figure can
be sorted by the labels in the Category column and filtered to show only costs that
are more than $20, as shown in Figure 6.16 "Sorting and Filtering in Microsoft Excel
2007".
Figure 6.16 Sorting and Filtering in Microsoft Excel 2007

Subtotals
If the user wants to find a subtotal of the values that belong in a particular group,
the groups must be identified by a label in one of the columns. Finding subtotals is a
two-step process. First, the table is sorted by that column to bring all the rows in
each group together. Next, the subtotal feature is applied. In Excel 2007, the

6.2 Selecting Software
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subtotal option is found on the Data tab, in the Outline group. A dialog box allows
the user to choose the columns to subtotal and the columns that contain the labels
of the groups. A subtotal is inserted below the last row for each group, as shown in
Figure 6.17 "Using Subtotals".
Figure 6.17 Using Subtotals

In a panel at the left of the screen are lines and symbols that indicate the level of
detail that is displayed. By clicking on the boxes with minus signs, the rows
containing the data can be hidden, leaving the subtotals or grand total, as shown in
Figure 6.18 and Figure 6.19. This feature allows a manager to view summary data
very quickly without the visual clutter of the details.
Figure 6.18

Third level details are hidden.

6.2 Selecting Software
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Figure 6.19

All details in rows 2–16 are hidden.

Graphics for Bar Charts and Milestones
Spreadsheets can be used for basic progress reports that show activities, dates, and
horizontal bars that represent the duration of an activity. A sequence of dates can
be created as column labels by entering the first two dates in the sequence,
selecting both dates, and then dragging the fill handle—a small square in the lower
right corner of the selected cell, as shown in Figure 6.20 "Creating a Sequence of
Dates"—to extend the pattern.
Figure 6.20 Creating a Sequence of Dates

The program is sophisticated enough to correctly fill date sequences between
months that have a different number of days and even account for leap years in
February. Because more sophisticated project management software uses a table
design in which the first two columns are description and duration, a similar
structure, in which those two columns are adjacent and in that order will make it
convenient to transfer the list of activities in a low-complexity project into the
project management software at a later date if the spreadsheet is not sufficient. In
the duration column, use the following abbreviations:
• d for days
• wk for weeks

6.2 Selecting Software
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• mons for months
The duration of each activity and the relationships between activities can be
illustrated using the drawing shapes. In Excel 2007, the same set of shapes and
connector arrows are available as those in Word 2007. A long rectangle can
represent a bar whose length represents the duration of the activity. Events or
significant dates in the project are identified with a diamond. The diamond can be
created by using a small square shape and rotating it. Arrows can be drawn between
the shapes to indicate their relationships, as shown in Figure 6.21 "Diagram of
Activities". Unfortunately, the arrows in Excel 2007 connect to handles on the sides
of the rotated squares instead of the corners. This detail may be overlooked in a
simple project diagram.
Figure 6.21 Diagram of Activities

This type of diagram is useful for projects with low complexity where a simple chart
of a few activities will suffice.

Software for Moderately Complex Projects
More complex projects involve more people who are often separated geographically
and who contribute to the same documents. Complex projects have more tasks with
more complex relationships. To manage those tasks and relationships, using
dedicated project management software and more sophisticated diagramming
software is justified.

Sharing Team Documents
If more than one person on a team will be contributing to a document, the
document must be accessible to them. To manage documents that are created by a
team, it is necessary to control the edits so that work is not lost or confused.

6.2 Selecting Software
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Version Control
Files such as word processing documents and spreadsheets may be stored on an
individual’s computer and copies sent to participants who then make changes and
return the revised version to the person who is responsible for the final version of
the document. If more than one person is editing his or her own copy of a document
at the same time, different versions of the document with different additions or
corrections are created. Word processing programs such as MS Word 2007 have a
feature that can compare two documents and identify the differences to help bring
the two different documents back together. This feature is found on the Review tab,
in the Compare group, as shown in Figure 6.22 "Compare Documents Feature".
Figure 6.22 Compare Documents Feature

Most software programs make periodic backups to protect from accidental power
loss. One of the ways that a user can still lose a lot of work is by replacing a newer
version of a document with an older version. It is possible to display the date on
which the file was last saved using the Details view. If more than one version of the
file exists in two different locations, the dates can be compared to determine which
is the most recent. These techniques are useful for simple projects with very few
participants.

File Storage and Access Control
Managing versions of documents that are edited by more than one person can be
done more effectively by placing the file in a location that can be accessed by all the
team members. This can be a shared drive on the company’s computer or on a
document sharing service. People who need to use the document are grouped by
their need for access. Three groupings are common:
1. View only
2. Edit only
3. Ownership/administrator

6.2 Selecting Software

260

Chapter 6 Communication Technologies

The owner or administrator of the document can set the access levels. These levels
of access can be assigned to each individual, or they can be assigned to named
groups and the person can be made a member of a group. The owner of the
document can choose to accept or reject changes made by those with edit-only
permission.
The advantage of this method is that there is only one version of the file. If a file is
being edited, it is usually locked so that other team members may view the file but
cannot edit it until the first editor closes the file.
If the file is stored on a computer that is on a secure network within an
organization, it can be difficult for team members who do not have direct
connections to the company’s network to get access to the files. To protect the
security of the company’s network, the network administrator can grant an outside
user permission to access the network from anywhere on the Internet using a
virtual private network (VPN)14 connection. A VPN uses encryption15—replacing
readable content with a code—to protect the communication between the network
and the user to make it secure. The VPN connection gets the user onto the company
network as if they were directly connected, but they still need the appropriate
passwords to access the shared documents.

Tracking Changes and Adding Comments
One of the features that is particularly useful for keeping track of the changes made
to a document by several users is called Track Changes. In Microsoft Word 2007, it is
found on the Review tab, in the Tracking group. Changes may be shown in the
document or in balloons at the side.

14. Method of connecting to a
network from the Internet
using a code to protect the
communication.

If a team member wishes to explain a change, it is very important that they do not
insert their explanation as text into the document. Such explanations might not be
deleted and would end up in the final version of the document with potentially
damaging results. Instead, team members can use a form of electronic sticky note to
make comments. This feature is found in MS Word 2007 on the Review tab, in the
Comments group. A change and a comment are shown in Figure 6.23 "Tracking
Changes and Adding Comments". The document owner must go through the
document and accept or reject each change and delete all the comments before the
document is released as a finished product. The Next, Accept, and Reject options are
found in Microsoft Word 2007 on the Review tab, in the Changes group.

15. Replacing readable content
with a code.
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Figure 6.23 Tracking Changes and Adding Comments

Diagramming Software
The processes and relationships in medium- and high-complexity projects usually
require more sophisticated software tools for creating reporting diagrams and
workflow charts. The market for diagramming software is more diverse than for
word processing and spreadsheets, and it is not as likely that most team members
will have the same programs that save files in the same formats. Microsoft Viseo
2007 is available as a stand-alone program that sells for several hundred dollars. For
medium-complexity projects, a free alternative to Viseo is Open Office Draw. Open
Office is a free software alternative that includes a word processing, spreadsheet,
presentation, and drawing programs. The Open Office Draw program, and others
like it, can create diagrams such as the one shown in Figure 6.24 "Diagram Created
Using Open Office Draw".
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Figure 6.24 Diagram Created Using Open Office Draw

The files created by the various drawing programs might not be compatible with
each other, but all the programs can create static image files that can be pasted into
word processing documents.

Project Management Software
The relationships between project activities can become complicated in mediumand high-complexity projects. Dedicated project management software can
compute the sum of activity durations along several different paths through
complex relationships and recalculate them immediately if any of the durations or
starting times are changed. Similarly, charts and reports are updated automatically
based on the new data. The most popular software for medium-complexity projects
is Microsoft Project. If a project manager begins work on the project in the belief
that it can be managed using a list of activities in a word processing program or in a
spreadsheet, the list of activities and their durations can be copied and pasted, or
imported, into the project management software’s table of activities, if the original
document or spreadsheet was designed with that possibility in mind, as shown in
Figure 6.25 "List of Activities Transferred to a Project Management Program".
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Figure 6.25 List of Activities Transferred to a Project Management Program

Once the data are placed in the project management software, the relationships can
be defined and reports created. Organizations on a tight budget might consider
using an open source16 program named OpenProject. Open source software is
usually available at no cost for individual users and with fewer restrictions than
proprietary software like Microsoft Project. OpenProject is similar to Microsoft
Project, as shown in Figure 6.26 "Open Source Project Management Software", and
could be used on low- and medium-complexity projects that do not need the more
advanced features available in Microsoft Project.
Figure 6.26 Open Source Project Management Software

Software for Complex Projects

16. Available at no cost for
individual users and with fewer
restrictions than proprietary
software.

6.2 Selecting Software

Complex projects can involve thousands of individual activities and a company
might have several projects going at the same time. Large, complex projects are
common in the construction industry. A software that is commonly used for
complex projects in construction is P3 or P6 from Primavera. It has the ability to
produce sophisticated reports that help project managers to anticipate problems
and make projections.
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Word processing documents often contain data that could be aggregated and
analyzed. Beginning with Microsoft Word 2007 and the .docx file format, it is
possible to insert characters called tags17 on either side of a particular section of a
form or document and assign a data label. For example, the name of the supplier on
an invoice could be enclosed between two tags: <supplier>Thompson
Hardware</supplier>. These tags resemble those used in the hypertext markup
language (HTML) to identify how to display text on a Web page, but instead of
telling a Web browser how to display the name of the supplier, it identifies
Thompson Hardware as the supplier. These tags are can be created by following a
set of rules called the extensible markup language (XML)18. Forms created using
XML can be scanned for the content that is marked by tags. The data can be
imported into a spreadsheet or database for analysis. Creating documents that use
XML to identify data in the forms can be done using Microsoft InfoPath. An example
that identifies key facts in a document that was prepared using InfoPath is shown in
Figure 6.27 "InfoPath Form with XML Tags". Because it takes extra effort to learn to
use InfoPath, or a similar XML authoring program, and to create the forms, this
approach is normally limited to complex and sophisticated organizations that have
the need to manage large amounts of data.
Figure 6.27 InfoPath Form with XML Tags

17. Labels that enclose text to
describe how it is displayed or
to give it meaning as data.
18. Rules for defining tags that can
identify text as data or for
display purposes.
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KEY TAKEAWAYS
• Low-complexity projects might be managed using general purpose word
processing and spreadsheet software by using the special features for
outlining, managing data, and inserting graphic objects
• Medium-complexity projects need special purpose software for
managing project activities, such as Microsoft Project, and graphic
software such as VISEO. Open source software such as OpenProject and
Open Office Draw may suffice.
• High-complexity projects need more sophisticated project management
software like P6 from Primavera. Forms can be created using XML tags
that allow data to be extracted from the documents.
• Files can be stored at a location that is accessible by all the team
members. They can be granted different levels of access, including view
only, edit only, and ownership. Features like track changes and compare
documents can help manage edits.
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EXERCISES
1. General purpose word processing and spreadsheet software might be
sufficient for managing _____ (low-, medium-, high-) complexity
projects.
2. Three features that are available in spreadsheet programs such as
Microsoft Excel to manage tables of data are subtotal, sort, and
_________.
3. If outline levels are assigned in a word processing document, the outline
may be _________ or expanded to hide or display different levels of
detail.
4. ______-________ (two words) software is often available at no cost, and
its use is less restricted than proprietary software.
5. A VPN connection uses ___________ to protect the content of the
communication.
6. How are XML tags similar to HTML tags and how are they different?
7. How should activity information be organized in a spreadsheet to make
it easier to transfer to a project management program?
8. What are three options for creating a diagram that displays a project’s
reporting hierarchy for low- or medium-complexity projects?
9. What is an example of a software product that is commonly used for
highly complex projects?
10. What are three levels of file access and editing permissions that can be
assigned, and what are examples of user groups that would be assigned
to each level?
Internalize your learning experience by preparing to discuss the following.
Describe an experience you might have had with editing the same word
processing document and how you managed the revisions. If you used some
of the features described above, how well did they work? What features were
described that might have been helpful?
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6.3 Exercises
Exercises at the end of the chapter are designed to strengthen your understanding
and retention of the information recently acquired in the chapter.

ESSAY QUESTIONS
Write several paragraphs to provide more in-depth analysis and
consideration when answering the following questions.
1. Assume that you are the leader of a virtual team that includes members
who are in New York, Bogotá, Honolulu, and Tokyo. You would like to
choose a day and time for a weekly conference call to keep the project
on track. Choose a day and time and explain your choice and the
compromises and problems it might cause for each member. Use the
term “synchronous” correctly and identify the specific time zone for
each participant.
2. From the list of available templates in your word processing or
spreadsheet software, choose a template and describe it. Fill it out and
then describe how it could be modified to meet the needs of a particular
situation or organization.

268

Chapter 6 Communication Technologies

DISCUSSION
The exercises in this section are designed to promote exchange of
information among students in the classroom or in an online discussion. The
exercises are more open ended, which means that what you find might be
completely different from what your classmates find, and you can all benefit
by sharing what you have learned.
1. Consider the newer synchronous and asynchronous communications
technologies with which you are familiar. Describe how they might be
used on projects in new and innovative ways. Relate these ideas to what
you learned about project cultures—specifically about innovation on
projects—and describe how the new communications technologies could
be used to innovate.
2. Describe your experience using Excel to manage data such as lists of
purchases. Discuss how the features of sorting, filtering, and subtotaling
could help answer questions about that list.
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6.4 Web Exercise
LEARNING OBJECTIVE
1. Determine the local time for team members in other time zones given
GMT or UT zone designations.

Using an Online Time Zone Map
Fortunately, there are several websites that provide the information you need to
schedule a conference call so that all the participants know the correct time and
day of the week regardless of where they are in the world.

How to Use a Website to Help Find Local Time
1. Open a word processing document. Save it as Ch06TZStudentName.doc.
Use the .doc file format.
2. On the first line, type Chapter 6 study documentation by and then type
your name. Press Enter to move the insertion point to the next line
3. Open a web browser and go to http://www.worldtimezone.com.
4. The map will display the world’s time zones at the time you visit the
site. See Figure 6.28 "World Times Compared to 6:40 p.m. EST". The
example in Figure 6.28 "World Times Compared to 6:40 p.m. EST" was
displayed on the author’s computer at 6:40 p.m. EST on Thursday,
December 18 (23:40 GMT).
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Figure 6.28 World Times Compared to 6:40 p.m. EST

5. Capture the screen that displays the World Time Zone Map with your
current time and date.
6. Switch to the word processing document and paste the screen capture
below the first line of text.
7. Below the image, type The time and date in India would be and then type
the time and date in India for your current time and date.
8. Review your work and use the following rubric to determine its
adequacy:
Element

6.4 Web Exercise

Best

Adequate

Poor

File name

Different
name or
Ch06TZStudentName.doc Ch06TZStudentName.docx
incompat
format

Determine
the local
time for
team
members in
other time

Title; screen capture
with current date and
time; correctly
calculated day and time
in India.

Same as Best

Incomplet
or an erro
in the tim
or date
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Element

Best

Adequate

Poor

zones given
GMT or UT
zone
designations

9. Save the file and submit it as directed by the instructor.
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6.5 Software and Technology Exercises
LEARNING OBJECTIVES
1. Locate the dialing codes for making international telephone calls.
2. Identify dialing techniques used with cell phones to make international
telephone calls.
3. Select the appropriate times and methods for making international calls.
4. Subscribe to a news service using a newsreader and RSS.

Placing International Calls
International Telephone Calls Using Wired Phones
The telephone may be used for two-person synchronous communication or in a
multipart conference call. Using a telephone to make long-distance and
international calls involves using international telephone numbering conventions.

Calls within North America and the Caribbean
The telephone companies in North America use the North American numbering
plan (NANP) that includes the United States, its territories, Canada, Bermuda, and
sixteen Caribbean nations.
Wired telephones are connected physically to a local
switch that can handle up to ten thousand connections
Figure 6.29 Rotary Dial
represented by the last four-digit numbers in a
Telephone
telephone number from 0000 to 9999. Each switch is
identified by a three-digit number such as 555. A local
telephone number consists of the switch number and
one of the ten thousand four-digit numbers such as 555
0112. This system can provide up to ten million different
unique phone numbers,The three-digit area code plus
the next four digits make up a seven-digit number. A
seven-digit number has ten million possible
combinations from 000 0000 to 999 9999. In practice,
some area codes are reserved for special purposes such
as trouble-shooting, emergencies, directory assistance,
and maintenance, so the maximum is less than ten million per area code. For
example, numbers 555-0100 through 555-0199 are reserved for fictional use and are
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not assigned to real customers. but it does not have the capacity to provide service
to billions of people.
The switches are grouped into areas and assigned a group number or area code.
Area codes in North America were assigned at a time when numbers were
converted to a sequence of electrical pulses by inserting your finger in a rotary
disc—the dial—and pulling it to a stop on a phone like the one shown in Figure 6.29
"Rotary Dial Telephone".
As a spring returns the dial to its original position, it opens and closes a set of
electrical contacts to create a series of pulses that match the number dialed.
Because it takes longer to dial higher numbers like 8 or 9, area codes that could be
dialed quickly like 212 and 213 were assigned to densely populated areas like
Manhattan (212) and Los Angeles (213). Higher numbers were assigned to rural
areas or to newer areas. As a result, it is difficult to determine where a telephone is
located by its area code. Do not assume that numbers with similar area codes in
North America are located in the same time zone—they may be thousands of miles
apart. To initiate a call to a different area code, the number 1 is dialed first. This is
the national direct dialing (NDD) code for NANP members.

Calling from North America to a Country outside the NANP

The IDD code for the United States is 011.

To make an international call from an NANP member such as the United States to
another country, you need to provide two codes: the international direct dialing
(IDD) code and the country code. The IDD code for the United States is 011. For
example, if you wanted to place a call to a number in Rio de Janeiro, you would
enter 011 55 21 xxx xxxx, where 011 is the IDD code for the United States, 55 is the
country code for Brazil, 21 is the area code for Rio de Janeiro, and xxx xxxx
represents the final seven digits of the number.

Calling to North America from a Country outside the NANP

The IDD and the country code are not simply reversible. The country code for
the United States is 1 (not 011).
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If you traveled to Rio de Janeiro for a meeting and wanted to call back to a number
in the United States from a local phone, you would have to look up the IDD code for
the local service provider in Brazil. In Brazil, there is a different code for each of the
five phone companies. The IDD for Brasil Telecom is 0014.
The IDD and the country code are not simply reversible. The country code for the
United States is 1 (not 011), so you would enter 0014 1 xxx xxx xxxx, where the last
ten digits are the area code and telephone number in the United States.

Reading the Phone Number on a Business Card in North America
It is commonly understood in the United States that you do not enter the hyphens,
parentheses, spaces, or periods that are used to make a telephone number more
readable and that you dial 1 first—even though it is not included—for a call destined
for a different area code. For example, if the phone number on the business card
shows (555) 222-1111, you know that you would enter 2221111 if you are calling
from within the 555 area codeSome area codes cover large geographic areas, and
the NDD code is required to dial a number from within the same area code if they
are far apart. or 15552221111 for a call from a different area code, but you would
not attempt to enter the parentheses, space, or hyphen. Spaces are used in some
instances in the following discussion to make the numbers easier to read in this
text, but it will be understood that they are not entered when dialing the number.

Reading the Phone Number on an International Business Card
Unlike those countries participating in the NANP, other countries use different
numbers for the national direct dialing (NDD) code and the country code. They
might use a different number of digits for the area or city code. A business card
from a team member in Rio de Janeiro might be +55 (0)21-xxxx xxxx where 55 is the
country code and 0 is the NDD code. To call this team member from the United
States on a wired telephone, you would enter 011 55 21 xxxx xxxx, where 011 is the
IDD for the United States, 55 is the country code for Brazil, and 21 is the code for Rio
de Janeiro.
Notice the zero between 55 and 21 is not included when calling from outside the
country. This is the NDD code that is used for calls between areas within the
country. For example, if you land in the airport at Sao Paulo, Brazil, and want to call
the person in Rio de Janeiro from a local phone, you would enter 0 21 xxxx xxxx
(without the spaces) where 0 is the NDD code—like 1 in the United States—and 21 is
the area/city code.
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Finding International Telephone Codes
1. Open a word processing document. Save it as
Ch06PhoneStudentName.doc. Use the .doc file format.
2. On the first line, type Chapter 6 study documentation by and then type
your name. Press Enter to move the insertion point to the next line
3. Open a web browser and go to http://www.kropla.com. This site
provides information on international dialing codes.
4. Near the middle of the page, click the International Dialing Codes link.
5. On the CountryCode.org page, in the Country column, scroll down and
click Brazil. A list of country codes and city codes is displayed next to a
map of the country.
6. Use the browser’s Back button to return to the CountryCode.org web
page. Add the address for this page to the Project Management folder
in your browser’s favorites or bookmarks.
7. Switch back to the browser. In the Country column, scroll down and
click one of the country names other than Brazil.
8. Capture the screen that shows the country’s code and map, paste it
into a blank document, and then save the document as
Ch06Exercises6.5.doc.

Making International Telephone Calls Using a Mobile Phone
To place an international call to a country outside the NANP using a mobile phone,
you use the plus sign (+) instead of the IDD code. For example, the number of the
British Museum is +44 (0) 20 7323 8000. To call this number from a wired phone in
the United States, you would dial 011 44 20 7323 8000. If you make the call from a
mobile phone, you dial +44 20 7323 8000. Notice the plus sign takes the place of the
IDD code.

Finding the Plus Sign on a Mobile Phone
Wired phones do not have a plus sign on their keypads, but recent model mobile
phones include a method to dial a plus sign. Unfortunately, the method varies by
brand of telephone.

International Telephone Calls Using a Mobile Phone
1. Open a web browser and go to
http://www.howtocallinternationally.com. This site has a step-by-step
demonstration of how to make calls using wired and mobile phones.
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2. At the right of the page under Shortcuts, click From a mobile (cellphone).
The How to call internationally from a mobile (cellular) telephone page
displays. Read this page.
3. Scroll down to the video and click the play button.
4. During the video, when a telephone number with a plus sign is
displayed on the cell phone, pause the video and capture the screen.
5. Paste the screen into Ch06PhoneStudentName.doc.
6. Switch back to the browser window and then watch the rest of the
video.
7. Add a link to this web page in your browser’s favorites or bookmarks.
8. Capture a screen that shows the links to CountryCode.org and
Howtocallinternationally.com in the Project Management folder in
your browser’s favorites or bookmarks and then paste it into the
Ch06PhoneStudentName.doc.
Element

Best

Adequate

File name

Ch06PhoneStudentName.doc

D
n
Ch06PhoneStudentName.docx
i
f

Choose the
correct
dialing codes
for making
international
telephone
calls

Title; screen capture showing
the country code and map of
one of the countries other
than Brazil

Same as Best

I
o
B

A screen capture from the
video on how to enter a plus
sign on a cell phone; a screen
capture that shows the links
to CountryCode.org and
Same as Best
Howtocallinternationally.com
in the Project Management
folder in the favorites or
bookmarks

C
s
c
n
p
s
o
t
s
b
f

Identify
dialing
techniques
used with
cell phones
to make
international
telephone
calls

9. Save the file and submit it as directed by the instructor.
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Practice Using International Dialing Codes
Selecting the appropriate numbers to use from a business card for placing an
international call requires practice. In this exercise, you practice using your
knowledge of international calling codes to compare your answers to reference
answers that are hidden on a spreadsheet.

Using a Spreadsheet for Practice
1. Navigate to the location where the student files for chapter exercises
are located and then open 6.3.3_PhonePractice.xls. Save the file as
Ch06PhonePracticeStudentName.xls using the Excel 2003 file format.
2. Use the skills you practiced in this chapter and in previous exercises to
answer the first question in cell C2. You are allowed to open a browser
and refer to websites for assistance.
3. Notice that if you type and enter the correct answer, in exactly the
format indicated, the cell background turns green, as shown in Figure
6.30 "Background Turns Green If Correct".
Figure 6.30 Background Turns Green If Correct

© Microsoft Corporation. All Rights Reserved. Used with permission from Microsoft Corporation.

4. Observe that column D is hidden. It contains a set of correct answers.
The spreadsheet’s conditional formatting feature is used to change the
background color if the cell content matches the hidden answer.
5. Use your web references and personal knowledge to answer the
remaining questions. Place the answers in column C. If some of the
answers do not turn green, check your work. If you cannot determine
the error, move on to the next question. Answer all the questions, even
if some of the answers are wrong or do not match the reference answer
exactly.
6. Select columns C through E. To accomplish this, you may click and drag
the column headings from C through E, or you can click the column C
heading, hold the Shift key, and click the column E heading. Columns
C, D, and E are selected, even though column D is hidden, as shown in
Figure 6.31 "Columns C, D, and E Selected".
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Figure 6.31 Columns C, D, and E Selected

© Microsoft Corporation. All Rights Reserved. Used with permission from Microsoft Corporation.

7. Move the pointer onto either column, then right-click. On the shortcut
menu, click Unhide. The answers in column D are displayed.
8. Locate any answers that are still displayed in red. Compare your
answer to the reference answer. In the Analysis column on the same
row, analyze and explain why your answer did not match the reference
answer. Use this opportunity to correct misunderstandings.
9. Save the spreadsheet. Check your work to assure that it is complete
using the following table:
Element

File name

Best

Adequate

Ch06PhonePracticeStudentName.xls Ch06PhonePracticeStuden

Select the
appropriate
times and
All incorrect answers are analyzed;
methods for the cause of the error correctly
making
identified
international
calls

All correct

10. Save the file and submit it as directed by the instructor.

Using a Newsreader
Some projects are directly affected by external factors such as political elections,
economic trends, corporate mergers, technological or scientific breakthroughs, or
weather. To keep informed about these factors, you can subscribe to online news
sources. A method that facilitates this process is Really Simple Syndication (RSS). To
use this service, you need a newsreader so you can subscribe to RSS feeds. For this
activity, you need a Google account. If you do not have one, go to Google.com and
create one for no cost.
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